
Messunsicherheiten, Fehlerrechnung und
lineare Regression

Jede Messung weicht vom wahren Wert der zu messenden Größe ab. Durch mehrfache Wiederholung der
Messung kann der Mittelwert einer Stichprobe, die Verteilung der Messabweichungen und die statistische
Unsicherheit des Mittelwertes berechnet werden. Diese Unsicherheiten pflanzen sich fort, wenn aus den
Messwerten andere physikalische Größen berechnet werden. Die Größtfehlerrechnung beschreibt die
Fortpflanzung einzelner Messunsicherheiten. Die lineare Regression ist ein elementares Werkzeug der
Datenauswertung, um Parameter aus einem Datensatz zu extrahieren.

1 Lernziele
• Zufällige Messabweichungen sind bei wiederholten Messungen oft normalverteilt (gaußverteilt).
• Durch Mittelwertbildung kann die Genauigkeit des Messwertes erhöht werden.
• Die Standardabweichung sX ist ein Maß für die Streuung um den Mittelwert.
• Die Standardabweichung des Mittelwertes sXm gibt die Messunsicherheit von diesem an.
• In Formeln mit mehreren Messgrößen pflanzen sich Messunsicherheiten fort. Die resultierende größt-

mögliche Messunsicherheit kann mittels partieller Ableitungen der beschreibenden Formel und den
gegebenen oder abgeschätzten Einzelmessunsicherheiten bestimmt werden (Größtfehlerrechnung).

• Die lineare Regression berechnet den Anstieg b und den Ordinaten-Abschnitt a (y-Achse), um die
Daten mit einem linearen Zusammenhang y = a + b · x zu beschreiben.

2 Experimenteller Aufbau – Mathematisches Pendel
• Stativ mit Skala, Fadenpendel und Probenkörper h = (30.0 ± 0.1)mm
• Maßband mit einer Ablesegenauigkeit von 1 mm
• StopWatch-Programm auf dem Computer zur Zeitmessung
• Computer mit Software zur Datenauswertung, QtiPlot

3 Vorbereitung und Fragen
Als Vorbereitung auf diesen Versuch wird eine einmalige Vorlesung und die Vorübung Federpendel
(siehe Webseite GP) angeboten. In der Vorlesung werden die konkreten Details und mathematischen
Hintergründe dieses Versuches beschrieben. Wenn Sie nicht daran teilnehmen konnten, setzen Sie sich mit
der angegebenen Literatur auseinander und erarbeiten Sie sich vor Versuchsantritt diese Schwerpunkte:

1) Arten von Messabweichungen und der Unterschied zu Messunsicherheiten
2) Mittelwert, Standardabweichung und Standardabweichung des Mittelwertes
3) zufällige Messabweichungen, Normalverteilung, Erwartungswert, Standardabweichung und Varianz
4) absolute und relative Messunsicherheit
5) Fehlerfortpflanzung und Größtfehler bei zusammengesetzten Messgrößen aus Formeln
6) Linearisierung der Zusammenhänge, zum Beispiel Auftragung T2(L) anstatt T(L)
7) Lineare Regression y = a + bx, dem y-Achsenabschnitt a (Intersection, Offset), dem Anstieg b

(Slope), und deren physikalischen Einheiten
8) Festlegung des y-Achsenabschnitts a = 0 (Ursprungsgerade) und die physikalische Entsprechung

4 Versuchsvorbereitung
Überprüfen Sie zu Beginn, ob eine Pendellänge L von zirka 80 cm eingestellt ist. Der Auslenkwinkel
des Pendels bei der Schwingung soll zirka 7° betragen. Lenken Sie es dazu auf 8° aus. Lenken Sie es
erneut aus, wenn die Amplitude auf unter 6° abgefallen ist. Zur Aufnahme der Periodendauern steht
das Programm StopWatch zur Verfügung. Bei diesem Programm lösen wiederholte Enter-Eingaben
jeweils Start oder Stopp der Uhr aus. Somit wird mit zwei Tastendrücken jeweils eine Periodendauer
gemessen und in eine Liste eingetragen. Um eine Periodendauer möglichst genau zu messen, stoppen
Sie die Zeit zwischen zwei Nulldurchgängen, bei denen das Pendel mit maximaler Geschwindigkeit (bei
der Auslenkung 0°) in gleicher Richtung durchläuft. Sie können zwischendurch pausieren, das Pendel
neu auslenken oder der Partner stoppt die Zeiten.
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5 Aufgabenstellung zur Messung - Durchführung - Auswertung
5.1 Mittlere Periodendauer Tm200 aus 200 Einzelmessungen

1) Messen Sie die Pendellänge L mit dem Maßband. Dies ist der Abstand zwischen dem Aufhängepunkt
und dem Schwerpunkt des Probenkörpers. Da die Pendelkörper genau 3 cm hoch sind, können
Sie bis zur Oberkante messen und dann 1.5 cm dazu addieren. Schätzen Sie die zugehörige
Messunsicherheit u(L) und notieren Sie beides in Ihrem Protokollbuch.

2) Bestimmen Sie mindestens 200-mal die Dauer Ti einer Periode Ihres Fadenpendels.
3) Kopieren Sie die ermittelten Zeiten in die Zwischenablage(Copy all). Markieren Sie die linke

obere Zelle einer Tabelle im Programm QtiPlot und fügen Sie den Inhalt der Zwischenablage ein
(Strg+V). Fügen Sie eine weitere Spalte hinzu und berechnen Sie die Periodendauern in Sekunden.
Vergeben Sie aussagekräftige Spaltennamen, siehe auch ->FAQ QtiPlot.

Auswertung: Histogramm und statistische Größen - ! Achtung ! Unsere Computer sind auf Englisch
eingestellt, daher gibt es nur Dezimalpunkte, keine Komma. Beachten Sie dies bei allen Eingaben.

a) Stellen Sie Ihre Daten als Punktdiagramm dar, indem Sie die Spalte mit den Periodendauern
markieren und Plot->Symbol->Scatter wählen. Löschen Sie offensichtliche Fehlmessungen aus
dem Diagramm mit Data->Remove Bad Data Points. Beschriften Sie die Achsen (Doppelklick).
Mit rechtem Mausklick auf das Diagramm und Add->Add Text können Sie Text hinzufügen, z.B.
das Datum und Ihre Namen. Mit File->Print Preview->Drucker können Sie Ihr Diagramm
ausdrucken.

b) Zur Ermittlung statistischer Größen der Periodendauern markieren Sie diese Spalte am Kopf
und benutzen Sie Statistics -> Descriptive Statistics -> Statistics on Columns.
Notieren Sie in ihrem Protokollbuch die mittlere Periodendauer Tm200 (Mean), die Standardabwei-
chung s (StandardDev) und die verwendete Anzahl N an Datenpunkten (letzter Zeileneintrag).
Berechnen Sie ebenfalls die Standardabweichung des Mittelwertes sTm = s/

√
N = u(Tm200).

c) Um ein Histogramm der Periodendauern vom vollen Datensatz zu erzeugen, markieren Sie
die zugehörige Spalte und benutzen die Zeichenfunktion Plot -> Statistical Graphs ->
Histogram. Mit einem Doppelklick auf das Histogramm können Sie die bin-Breite verändern, im
Layer1 auf Table gehen und bei Histogramm Data den Haken bei Automatic Binninig entfernen.

d) Fügen Sie eine Gaußverteilung der Abbildung hinzu. Erzeugen Sie diese mit Rechtsklick auf die
Abbildung und ->Add Function und tragen Sie den folgenden Funktionsausdruck

y(x) =
NB√
2πs2

exp
(
− (x − Tm200)2

2s2

)
(1)

in das Textfenster und die Werte für die Bin Breite B sowie die Parameter N, Tm200 und s aus
der statistischen Analyse ein. In Computersyntax ist dies:
N*B/sqrt(2*pi*sˆ2)*exp(-(x-Tm200)ˆ2/2/sˆ2), das ˆ ist oben neben der 1 auf der Tastatur.

e) Mit Doppelklick auf die Funktion können Sie die Breite auf 3 hinaufsetzen, damit Sie besser zu
erkennen ist. Diese Funktion sollte recht gut Ihr Histogramm beschreiben. Die Standardabweichung
in ms ist ein Maß für Ihre Reaktionsgenauigkeit. Die Pendelschwingung hat keine Ungenauigkeiten.
Sie haben manchmal etwas zu früh und manchmal etwas zu spät gedrückt. Auch wenn Sie hier
die Ursache der Verteilung waren, ist diese Gaußverteilung aber ein sehr allgemeines Phänomen,
was bei vielen Messungen auftritt. Durch die wiederholte Messung können dann der Mittelwert
und die Standardabweichung angegeben werden.

f) Tragen Sie die Werte für Tm200, s und sTm als Textfeld in die Abbildung ein. Geben Sie Tm200,
richtig gerundet mit der zugehörigen Unsicherheit an.
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5.2 Periodendauer T50 aus dem Zeitintervall für 50 Schwingungen
Bestimmen Sie zur selben Pendellänge die Periodendauer Tm50 = ∆t50/50 aus der gemessenen
Zeitdauer ∆t50 für 50 Perioden. Es wird einmalig mit Stopwatch die Zeitdauer ∆t50 gemessen,
diese ist zirka (70 −−100) s lang. Sie wissen aus dem vorherigen Versuch bereits, dass die
Unsicherheit einer Zeitintervallmessung bei Ihnen Experiment s ist. Demzufolge ist die Unsicherheit
u(Tm50) = s/50. In Worten: Die Unsicherheit ist in diesm Fall ein 1/50 der Messunsicherheit
einer einzelnen Zeitintervallmessung.

Auswertung: g-Bestimmung und Größtfehlerrechung
a) Der Zusammenhang zwischen der Periodendauer der Pendelschwingung T, der Pendellänge L und

der lokalen Schwerebeschleunigung g ist bei kleinen Auslenkungen: T = 2π
√

L/g:

T = 2π

√
L
g

−→ g =
4π2L

T2 (2)

Berechnen Sie gTm200 und gTm50 zum einen mit dem mittlerem T aus der Messung von 200
Einzelperioden und zum anderen aus der Messung über 50 Perioden.

b) Zur Ermittlung der Messunsicherheiten für diese zwei berechneten g-Werte benötigen Sie die
abgeschätzte Messunsicherheit u(L) und die Unsicherheit der jeweiligen Periodendauer u(T). Bei
der ersten Methode mit Tm200 ist die Unsicherheit der Periodendauerbestimmung u(Tm200), also
die Unsicherheit des Mittelwertes. Bei der zweiten Methode ist u(Tm50) = s/50.

c) Welche Unsicherheit ist größer? Was würden Sie vorschlagen, um bei Experiment 1 die jeweilige
Messunsicherheit zu verkleinern und was bei Experiment 2?

d) Wir verwenden die Fehlerfortpflanzung für die zwei berechneten Schwerebeschleunigungen g nach
Gl. (2). Die zugehörigen absoluten Messunsicherheiten uabs(g) haben zwei Anteile, u(L) und
u(T):

uabs(g) =
4π2

T2 u(L) +
8π2L

T3 u(T) . (3)

Berechnen Sie die Summanden separat und deren Summe für beide g. Welche Messunsicher-
heit u(L), u(Tm200) bzw. u(Tm50) hat jeweils den größten Beitrag zur Gesamtunsicherheit der
bestimmten Schwerebeschleunigungen g?

e) Welche der beiden Methoden - 200 Einzelperioden oder 50 Perioden - führt bei Ihnen zu einem
präziseren g?

f) Geben Sie abschließend Ihre zwei g Werte korrekt gerundet an, also auf die höchste signifikante
Dezimalstelle der auf eine Stelle gerundeten Unsicherheit, z.B. gTm50 = (9.79 ± 0.03)ms−2.

g) Berechnen Sie ebenfalls die zwei relativen Messunsicherheiten urel(g) = u(g)/g · 100%.
5.3 Schwerebeschleunigung g aus der linearen Regression

Messen Sie die Periodendauer T(L) Ihres Pendels für mindestens 5 Pendellängen Li zwischen
10 cm und 1.3 m. Ein Wertepaar haben Sie schon. Entscheiden und begründen Sie anhand obiger
Fehlerrechung, ob Sie zur Bestimmung der Periodendauer die Mittelwertmethode oder die Messung
der Dauer von nun 30 Perioden benutzen?

Auswertung: lineare Regression
a) Das Quadrat der Periodendauer T2(L) ist eine lineare Funktion in der Pendellänge L mit dem

Parameter gcorr. Der Anstieg ist b ohne Offset a:

T2(L) = 0 +
4π2

g
L ⇔ y(x) = a + bx mit a !

= 0 (4)

Welche Einheit haben a und b? Die lineare Regression mit y = a + bx berechnet optimale Werte
für a und b zu den Wertepaaren {xi = Li ; yi = T2

i }. Hier ist jedoch nur Anpassung an eine
Ursprungsgerade y = bx physikalisch sinnvoll. Die Regression ist eine weitere Methode gegenüber
der Bestimmung von gi aus den Einzelmessungen von Ti, Li-Paaren.

b) In einer neuen Tabelle ist die erste Spalte die x-Spalte und beinhaltet die zugehörigen Längen Li
in Metern. Die zweite Spalte die ermittelten Periodendauern Ti in Sekunden. Fügen Sie ein dritte
Spalte hinzu und berechnen Sie mit (col(2))^2 das Quadrat der Periodendauer in s2.
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c) Erstellen Sie einen Scatter-Plot von T2(L).
d) Berechnen Sie den Regressionparameter b ->FAQ QtiPlot. Wenn Sie auf die Linie doppelt klicken,

können Sie mit Edit den x Bereich bei 0 beginnen lassen.
e) Berechnen Sie aus dem Regressionsparameter b die Schwerebeschleunigung g.
f) Die Software gibt ihnen auch die Unsicherheit des Anstieges u(b) aus. Berechnen Sie die Unsi-

cherheit von g unter der Annahme, dass die Längenmessungen Li fehlerfrei sind:

u(g) =
4π2

b2 u(b) (5)

g) Geben Sie den Wert g mit seiner Unsicherheit richtig gerundet (Hinweis: die signifikante Dezimal-
stelle der Unsicherheit) mit Einheit als Text in Ihrer Regressionsabbildung an.

6 Literatur
Wenn Sie sich im Intranet der Universität befinden, können die angegebenen Bücher über die URL
kostenlos heruntergeladen werden. Die Referenz [2] ist ein allgemeines Praktikumsbuch, welches bei
vielen Versuchen hilfreich ist. Speziell die „Fehlerrechung leicht gemacht“ (https://www.physik.uni-jena.de/
pafmedia/Praktika/Physikalisches+Grundpraktikum/LGFehlerrechnungLeichtGemachtPDF.pdf) des Physikpraktikums
der Universität Jena wird ihrem Namen gerecht.
[1] Universität Oldenburg, Skript - Praktikum Physik. 2019, https://uol.de/f/5/inst/physik/ag/physikpraktika/

download/GPR/pdf/Fehlerrechnung.pdf.
[2] W. Schenk and F. Kremer (Hrsg.), Physikalisches Praktikum. Springer, 14. Auflage, 2014, http://dx.doi.org/

10.1007/978-3-658-00666-2.
[3] D. Meschede, Gerthsen Physik. Springer, 25. Auflage, 2015, http://dx.doi.org/10.1007/978-3-662-45977-5.
[4] P. A. Tipler, Physik für Wissenschaftler und Ingenieure. Springer Spektrum, 2019, https://doi.org/10.1007/

978-3-662-58281-7.

7 Zusatzmaterial
• Die Schwerebeschleunigung setzt sich aus dem lokalen Gravitationsfeld und der Zentrifugalbe-

schleunigung zusammen. Letztere hat ihr Maximum am Äquator und ist bei der Erde −0.34%.
• Die Messung des lokalen Schwerefeldes der Erde wird Gravimetrie bezeichnet. Die Hauptkompo-

nente in den lokalen Variationen der Fallbeschleunigung g sind Berge und Täler. Sie gibt aber auch
Hinweise auf eventuell vorhandene Erz- oder Öllagerstätten im Untergrund. Beim Vorhandensein
von Erzen oder Öl, ist die Fallbeschleunigung an der Oberfläche geringfügig größer bzw. kleiner
als aus dem Obeflächenprofil zu erwarten wäre.

Das lokale Schwerefeld um
Saarbrücken zeigt die Abnahme
von g mit der Höhe.
Siehe bei der Physikalisch
Technischen Bundesanstalt
https://www.ptb.de/cms/en/ptb/

fachabteilungen/abt1/fb-11/

fb-11-sis.html

https://www.physik.uni-jena.de/pafmedia/Praktika/Physikalisches+Grundpraktikum/LGFehlerrechnungLeichtGemachtPDF.pdf
https://www.physik.uni-jena.de/pafmedia/Praktika/Physikalisches+Grundpraktikum/LGFehlerrechnungLeichtGemachtPDF.pdf
https://uol.de/f/5/inst/physik/ag/physikpraktika/download/GPR/pdf/Fehlerrechnung.pdf
https://uol.de/f/5/inst/physik/ag/physikpraktika/download/GPR/pdf/Fehlerrechnung.pdf
http://dx.doi.org/10.1007/978-3-658-00666-2
http://dx.doi.org/10.1007/978-3-658-00666-2
http://dx.doi.org/10.1007/978-3-662-45977-5
https://doi.org/10.1007/978-3-662-58281-7
https://doi.org/10.1007/978-3-662-58281-7
https://www.ptb.de/cms/en/ptb/fachabteilungen/abt1/fb-11/fb-11-sis.html
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Grundeinstellungen  

• Wir empfehlen, einige Änderungen in den Grundeinstellungen des Programms. Dazu finden Sie auf der 
Internetseite des HIZ (Qtiplot Campuslizenz) neben den Installationsdateien eine Konfigurationsdatei 
(“empfohlene Programmeinstellungen”, download mit rechtem Mausklick) zum Importieren: 
> Edit > Preferences > Load Settings...” (ganz unten), “suggested_qtisettings.ini” auswählen und laden. 

 
Allgemeine Hinweise zum Zahlenformat  

• Je nach Spracheinstellungen zählt entweder der Punkt oder das Komma als Dezimaltrennzeichen. Im Physik 
Grundpraktikum ist auf allen PCs das englischsprachige Zahlenformat eingerichtet, daher muss dort der Punkt 
verwendet werden.  

• Das Zahlenformat 1.23e+04 bedeutet 1.23104 = 1.2310000 = 12300 
 

Noch ein guter Rat – speichern Sie während der Auswertung regelmäßig Ihre Datei um Datenverlust bei einem 
möglichen Absturz des Programms zu vermeiden! 
 
F1: Wie wähle ich eine Spalte, eine Zeile oder die gesamte Tabelle aus? 

• Um eine einzelne Spalte, eine einzelne Zeile oder die gesamte Tabelle auszuwählen, klicken Sie mit der 
linken Maustaste auf den Spaltenkopf (oben), den Zeilenkopf (links) oder das Feld in der linken oberen Ecke. 
Mit gedrückter “Shift”-Taste können Sie wie gewohnt auch mehrere Elemente auswählen. 
 

F2: Wie ändere ich die Spaltenbezeichnungen? 
rechter Mausklick auf den Spaltenkopf > Column Options...> Column Name: _ > Apply 

 
F3: Wie erzeuge ich eine neue Tabelle? 

> File > New > New Table oder (Strg + t) 
 

F4: Wie importiere ich Daten aus dem clipboard? 
 Linker Mausklick in die erste Zelle (z.B. Spalte 1, Zeile 1), rechter Mausklick > Paste  

Hinweis zum Import aus CassyLab: Die Tabelle enthält eine Kopfzeile mit Spaltenbeschriftungen. QtiPlot 
fragt, wie die erste Zeile interpretiert werden soll. Wählen Sie “Column Names” oder “Ignore”. 

 
F5: Wie importiere ich Daten aus einer Datei? 

> File > Import ASCII …  
Die Einstellungen hängen vom Format der Datendatei ab. Achten Sie insbesondere auf die richtige 
Einstellung des Dezimaltrennzeichens und möglicher Kopfzeilen. Das Import-Fenster zeigt eine Vorschau der 
Datentabelle.  
 

F6: Wie füge ich eine neue Spalte ein und berechne die Spaltenwerte? 

• Rechter Mausklick in die Tabelle > Add Column oder Doppelklick rechts neben den letzten Spaltenkopf 

• Spalte auswählen > Set Column Values oder in den Column Options das ∑-Symbol anklicken.  

• den Funktionsausdruck (z.B. col(“2”)^2) eintragen > Apply 
 

F7: Wie erstelle ich einen scatter plot? 
rechter Mausklick auf den [Y]-Spaltenkopf in der Tabelle > Plot > Symbol > Scatter 
(Hinweis: Die Einträge in der Tabelle müssen als „Zahlen“ formatiert sein. Bei Bedarf überprüfen und 
korrigieren: rechter Mausklick auf Spaltenkopf > „Column Options“) 

 
F8: Wie lege ich fest, welche Spalte die x- und die y-Achsen definieren? 

Wählen Sie die Spalte aus, rechter Mausklick > set as ...(X, Y, none...) 
 

F9: Wie entferne ich einen offensichtlichen 1) Ausreißer aus der Grafik?  
Grafik auswählen > Data > Remove Bad Data Points > (…Continue) > Doppelklick auf den Punkt 

Das Entfernen eines Datenpunktes ist eine Manipulation des Ergebnisses und darf nicht ohne 
Begründung erfolgen. Die Aussage „Der Punkt liegt nicht an der Stelle, wo ich ihn gerne hätte“ stellt keine 
ausreichende Begründung dar. 
 

F10: Wie ändere ich Elemente (Achsenskalierung, Beschriftungen…) in einer Grafik? 
a) Doppelklick oder  
b) rechter Mausklick auf das grafische Element > Properties, oder  
c) über Menüleiste > Format 
danach > Apply 
 

 



F11: Wie ermittle ich Mittelwert und Standardabweichung einer Datenreihe? 
rechter Mausklick auf den Spaltenkopf in der Tabelle > Statistics on Columns 
 
 

F12: Wie füge ich eine Linie in die Grafik ein oder lösche eine Kurve? 

• mit > Graph > Draw Line eine Linie zunächst von Hand in die Grafik einzeichnen 

• durch Doppelklick auf die Linie das Kontextfenster öffnen 

• auf der Karte “Geometry” die x- und y-Koordinaten von Anfangs- und Endpunkt eintragen. 
 

Zum Löschen... 

• rechter Mausklick in die Grafik > Properties 

• in der Liste links einen rechten Mausklick auf das zu löschende Element  > Delete 
 
F13: Wie füge ich ein Textfeld in eine Grafik ein? 

> Graph > Add Text > linker Mausklick in die Grafik öffnet den Texteditor (Das Textfeld kann mehrzeilig sein) 
 

F14: Wie erstelle ich aus den Daten einer Tabellenspalte ein Histogramm? 
rechter Mausklick auf Spaltenkopf > Plot > Statistical Graphs > Histogram 
 

F15: Wie passe ich die Balkenaufteilung („bin size“) des Histogramms an? 
rechter Mausklick auf Balken > Properties, Dateneintrag (Table:Spalte) auswählen > Histogram Data >  
uncheck „Automatic Binning“, danach “Bin Size”, “Begin” und “End” der Größenklassen sinnvoll einstellen. 
 

F16: Wie füge ich einen Funktionsgraphen, z.B. eine Gaußfunktion in die Grafik ein? 

• Grafikfenster auswählen, > Menü Graph > Add function.  

• Im Feld “f(x)=” den Funktionsausdruck (z.B.  (N*B/sqrt(2*pi*s^2))*exp(-(x-x0)^2/(2*s^2)) eintragen.  

• Wenn Sie für Parameter keine Zahlenwerte sondern Buchstaben verwenden, öffnet sich ein Fenster, in dem 
jedem Parameter ein Wert zugeordnet und später einfach verändert werden kann. Das ist nützlich, wenn der 
Parameter im Funktionsausdruck mehrfach auftaucht. 

• Den Start- und Endwert von x und die Anzahl der Punkte festlegen, für die f(x) berechnet werden soll > Apply 
 

F17: Wie kann ich eine Funktion nachträglich verändern? 

• Rechter Mausklick in die Grafik > Properties 

• Im linken Fenster die Funktion auswählen > Function  
 

F18: Wie ermittle ich die beste Ursprungsgerade durch Datenpunkte in einer Grafik? 

• rechter Mausklick in die Grafik > Analyze > Fitting > Fit slope 

• Falls die Grafik mehrere Datensätze enthält, öffnet sich ein Fenster zur Auswahl. 

• Das Ergebnis der Regression finden Sie im Fenster “Results log”, das Sie ggf. unter >View aktivieren müssen 
 

 
F19: Die Fitkurve beginnt nicht im Achsenursprung. Wie kann ich das anpassen? 

• rechter Mausklick in die Grafik > Properties 

• in der Elementliste die Fitgerade auswählen und unter der Formel “From x=... To x=...” anpassen > Apply 
 
 

F22: Wenn ich die Fenstergröße ändere, dann wird die Graphik nicht mitskaliert. Wie kann ich das ändern? 

• Edit > Preferences > 2D Graphics > Options >  

• tickmark entfernen bei „do not rescale layer upon change of window size“  
Siehe auch Grundeinstellungen (oben) 

 
 
 
Ausführlichere Bedienungshinweise finden Sie in der Hilfe-Funktion von QtiPlot. 



Fehlerrechnung 

Im folgenden Artikel steht alles drin, was man wissen muss, um fehlerrechnungstechnisch gut durchs 
Praktikum zu kommen. Einiges wird vielleicht auch darüberhinaus noch von Nutzen sein. Es geht um 
folgende Fragen:

I.	 Motivation: 
		  Warum braucht man „Fehlerrechnung“?
II.	 Wie schätze ich die Genauigkeit meiner eigenen Messwerte 	
	 realistisch ab?
III.	 Was tun, wenn mehrere Messgrößen zusammenwirken? 
		  Dafür gibt es einfache Methoden: Addition absoluter bzw. relativer Fehler, 		
		  Einsetzen von Maxima und Minima.
IV.	 Was, wenn das nicht reicht?
		  Dann kann man „partiell differenzieren“. Diese Variante wird kurz angerissen.
V.	 Wenn ich fertig bin, wie schreibe ich mein Ergebnis mit 		
	 seinen Genauigkeitsgrenzen sinnvoll auf?

Im Anhang werden einige Dinge dann noch etwas genauer beleuchtet.

leicht gemacht
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Der Begriff „Fehlerrechnung“ ist eigentlich irreführend. Niemand kann Fehler „berechnen“. Man kann versuchen, 
sie sinnvoll (realistisch) abzuschätzen. Das ist oft nicht einfach, aber dafür u.U. ziemlich wichtig. Man stelle sich z.B. 
vor, bei irgendeinem Genehmigungsverfahren irgendeiner Behörde muss entschieden werden, ob ein gesetzlicher 
Grenzwert (Schadstoffe, Lärm etc.) eingehalten wird oder nicht. Der Grenzwert sei  400, der gemessene Wert  390. 
Natürlich ist 390 kleiner als 400, kann also nun die Genehmigung erteilt werden? Formal ja, aber der kritische Be-
trachter wird sofort die Frage nach der Genauigkeit der Messung  stellen. Wenn  z.B. die Messmethode nur eine Ge-
nauigkeit von  ± 20 hat, so könnte ja bei einer Kontrollmessung statt 390 z.B. der Wert 410 herauskommen. Damit 
wäre die Grundlage für die Genehmigung nicht mehr gegeben. Wenn es dabei vielleicht noch um ganz viel Geld, 
Menschenleben o.ä. geht, kann  man sich den daraus entstehenden  Ärger sehr leicht ausmalen. Läge die Messge-
nauigkeit hingegen reproduzierbar bei  z.B. ± 1, wäre die Aussage der Messung eine ganz andere.

1. Einige vorausgehende Gedanken

2.  Die Genauigkeit meiner Messung 

Wie schätze ich sie ab? Uns interessieren hier erst einmal nur die zufälligen Fehler, denn eine „Fehlerrechnung“ 
wird (zumindest in der Physik) grundsätzlich nur mit zufälligen Fehlern gemacht. Wenn Sie irgendwo etwas ande-
res hören oder lesen, glauben Sie es nicht bzw. fragen Sie nach, wie das im konkreten Fall gemeint ist. 

Alle Mess- (Ablese-)unsicherheiten, Messgerätetoleranzen, Schwankungen der Anzeige etc., vereinfacht gesagt 
alles, wo man ein „±“ davor schreiben kann, sind zufällige Fehler.  Auch die Unsicherheiten statistisch gewonnener 
Messgrößen gehören dazu. Zufällig heißt: der Messwert x kann sowohl nach oben (+) als auch nach unten (-) vom 
tatsächlichen Wert abweichen, und der Betrag der Abweichung kann zwischen Null (zufällige exakte Übereinstim-
mung) und einem Maximalwert Δx  („Größtfehler“) liegen.

Das Maß für die Genauigkeit ist also die Größe Δx, die maximal mögliche Abweichung meiner Messung von dem, 
was eigentlich richtig wäre.

Auch im normalen Alltag kann 
es immer mal vorkommen, dass 
man sich mit der Genauigkeit 
einer Messung  auseinander-
setzen muss. Ein Beispiel dazu 
findet sich im Anhang. Es ist 
sicher nicht verkehrt, erstmal 
dort nachzulesen.

Nun zum eigentlichen Thema 
und gleich zum Schwierigsten 
überhaupt:

Man sieht im Übrigen an diesen Beispielen auch, dass es 

nicht um Fehler geht im Sinne von „etwas falsch ma-

chen“, sondern um die Unsicherheit, die grundsätzlich 

jeder Messung anhaftet. Es geht um die Abschätzung der 

Genauigkeit einer Messung. Da sich der Begriff „Fehler-

rechnung“ weitgehend eingebürgert hat, wird er trotzdem 

im Folgenden noch weiter verwendet, obwohl der Begriff 

„Genauigkeitsabschätzung“ der richtige wäre.

	 Fazit: Zu einem gemessenen Wert gehört immer auch eine Aussage 	
		   über die Genauigkeit der Messung.

Was sind zufällige Fehler? 
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Wo kriegt man das 
Δx her?
In den meisten Fällen gibt es nur eine 
Möglichkeit: abschätzen! Manchmal kann 
man sich auch an Vorgaben orientieren, 
was die Sache leichter macht. Bei Schwan-
kungen einer Anzeige z.B. (Zeiger oder 
digital) fällt Δx (die Schwankungsbreite) 
direkt ins Auge. Oder bei Messgerätetole-
ranzen: diese stehen auf dem Gerät bzw. 
im Begleitheft. 

Erste Idee: die linke Kante liegt bei 22.3 cm. Gut geschätzt. 
Wäre auch 22.2 möglich? Evtl. ja, … aber eher nicht. 
22.4? Ja, wäre denkbar. 
22.5?  Nein, auf keinen Fall.  

Fazit: das Ergebnis liegt offenbar zwischen 22.3 cm (als Minimum) und 22.4 cm (als Maximum), d.h. wir schreiben: 
(22.35 ± 0.05) cm. Kann sein, dass jemand der Meinung ist, auch 22.2 kommt noch in Frage. O.k., dann schreibt er:  
22.3 ± 0.1. Das muss letztendlich jeder für sich selber entscheiden.

Gleiches gilt für den Wert rechts:  hier werden die meisten eine Spanne von 28.1 bis 28.2 als möglich erachten, d.h. 
das  Ergebnis ist:  (28.15 ± 0.05) cm. Man sieht hier sehr schön, dass Skalen, wenn sie groß genug sind, durchaus auf 
Zehntel ihrer Teilstriche geschätzt werden können (entsprechend mit ± halbem Zehntel als Fehler) und nicht etwa 
nur auf halbe Skalenteile.

Die Länge des Rechtecks ist:  L = 28.15 cm – 22.35 cm = 5.8 cm.
Die Unsicherheit der abgelesenen Werte war ± 0.05 cm; wie groß ist der Fehler der Differenz, also ΔL?  Man kann 
es sich schon denken:  0.05 cm + 0.05 cm = 0.1 cm. Doch dazu gleich noch mehr.

Beispiel für die Abschätzung von Messungenauigkeiten:

Es soll die Länge eines Rechtecks mit einem 
Lineal gemessen werden (links ablesen, 
rechts ablesen, Differenz bilden). Wo liegt 
der Messwert links und wie genau ist er? 
Eine Schätzung (ohne weitere Hilfsmittel) 
könnte so vor sich gehen:

Aber Vorsicht: die Hersteller geben oft unrealistisch große Toleranzbereiche an, um auf der „siche-
ren Seite“ zu sein. Nachprüfen bzw. Nachfragen beim Assistenten  ist angebracht! Ansonsten hilft 
nur selber genau hinschauen und austesten, wie im folgenden einfachen Beispiel gezeigt wird: 
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Diese Regel ist sehr einfach zu verstehen. 

 
Links wurden (22.35 ± 0.05) cm gemessen, rechts (28.15 ± 0.05) cm. 
Die Differenz (unser Ergebnis) ist 28.15cm – 22.35cm = 5.80cm, die Genauigkeit des Ergebnisses müsste (Additi-
on der absoluten Fehler) 0.05cm + 0.05cm = 0.10cm sein (wir hatten es schon vermutet). 
Das Ergebnis lautet demnach L = (5.8 ± 0.1) cm. 

 
Wir überprüfen die Regel, indem wir die maximal und minimal möglichen Werte anschauen, die vorkommen 
können. Maximal  28.2cm – 22.3cm = 5.9cm, minimal  28.1cm – 22.4cm = 5.7cm, Ergebnis  L = (5.8 ± 0.1) cm. 
Es stimmt.

Methode 1: 

3. Drei einfache Methoden...

Die Abschätzung der Messgenauigkeiten muss man bereits während der laufenden Mes-
sungen vornehmen solange man alles noch vor Augen hat, nicht erst nachträglich (zu Hause) beim Aus-
werten. Dieser Teil der Fehlerbetrachtung ist problematischer als die eigentliche Fehlerrechnung. Wenn näm-
lich die Ausgangsgrößen unrealistisch abgeschätzt wurden, kann auch die genaueste Rechnung daraus nichts 
Vernünftiges mehr machen.

Dort, wo es möglich ist, sollte man eine Messung mehrmals wiederholen, um dadurch ein 
Gefühl für die Messgenauigkeit zu entwickeln. Bei vielen Wiederholungen unter identischen Bedingungen 
können zur Auswertung (Mittelwert x, Genauigkeit des Mittelwertes Δx ) statistische Methoden herangezogen 
werden. Dazu gibt es jede Menge Literatur.

Jetzt aber zu der Frage, die eben schon mal im Raum stand: Genauigkeit links, Genauigkeit rechts, wie genau 
ist die Differenz? Also was tun, wenn mein Messwert noch nicht das (End-) Ergebnis darstellt, sondern dieses 
erst (wie häufig in der Physik) mit Hilfe einer Gleichung aus mehreren gemessenen Größen ermittelt wird?
Das ist dann die eigentliche sogenannte Fehlerrechnung (manchmal auch als „Fehlerfortpflanzung“ bezeich-
net).

...die in den meisten Fällen zum Erfolg führen:

Vorher noch ein paar wichtige Bemerkungen für 
den Messvorgang: 

Wir betrachten dazu unser Beispiel:

Stimmt das?

	 Bei Summen und Differenzen addieren sich die absoluten Fehler.



± 

Interessant ist im vorliegenden Fall, dass die Fehleranteile 

der beiden Messgrößen (L, B), aus denen das Ergebnis (A) 

berechnet wird, sehr verschieden sind. Während die Länge 

L auf 1.7% genau bestimmt wird, geht die Breite B mit 

11.1% ein und macht damit den Hauptanteil des Gesamt-

fehlers von 12.8% aus. Das ist logisch, da der absolute Feh-

ler mit  ± 0.1 cm bei beiden Größen zwar derselbe ist, bei 

einer Strecke von 0.9 cm aber viel stärker zu Buche schlägt 

als bei 5.8 cm.
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Methode 2a: Kombination aus 1 und 2

Wenn in einer Gleichung Produkte/Quotienten gemischt mit Summen/Differenzen vorkommen, so kann 
man in vielen Fällen durch geschickte Kombination der Addition absoluter bzw. relativer Fehler zum Erfolg 
kommen. Man muss allerdings dabei ein bisschen nachdenken.

Exponenten werden dabei zu Vorfaktoren. 
Warum? Einfach gesagt: aus  y² = y ∙ y  wird  . 
Oder man erklärt es über die 1. Ableitung: aus  y²  (abgeleitet) wird  2 ∙ y.

Beispiel: 

Methode 2 gilt auch für mehr als zwei Messgrößen und darüber hinaus für Quadrate oder höhere Exponenten.

Angenommen, uns interessiert die Fläche des Rechtecks. Die Länge war L = (5.8 ±  0.1) cm, 
die Breite sei B = (0.9 ± 0.1) cm. Damit erhalten wir für die Fläche  
A = L ∙ B = 5.8 cm ∙ 0.9 cm = 5.22 cm². 

Für den relativen Fehler der Flächenbestimmung (Produkt zweier Messgrößen) gilt:

 0.017 + 0.111  =  0.128  (entspricht 12.8%).

Der absolute Fehler ergibt sich daraus zu:  

ΔA = 0.128 ∙ 5.22cm²  =  0.668 cm²  

Sinnvoll gerundet 0.67 oder 0.7. Man könnte es auch so ausdrücken:  12.8%  von  5.22 cm²  sind  0.668 cm².

Zurück zu unserem Beispiel:



E 

x 
E =         x 
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Manchmal ist es ja auch möglich, eine scheinbar komplizierte Formel in Hinblick auf die Fehlerrechnung zu ver-
einfachen, indem Summen bzw. Differenzen geschickt zusammengefasst oder einzelne Größen (mit kleinen Fehler-
grenzen) vernachlässigt werden. Ein Beispiel dazu ist im Anhang zu finden.

In vielen Fällen führen unterschiedliche Methoden zum Erfolg. Man nimmt dann diejenige, welche einem am meis-
ten zusagt. Das Ergebnis sollte in allen Fällen dasselbe sein. Auch hierzu gibt es ein Beispiel im Anhang.

Mathematisch gesehen ist das eine Taylor-Reihenentwicklung, die nach dem linearen Glied abgebrochen wird. Bei 
mehreren Messgrößen erhält man:

Diese Methode funktioniert bei 
kleinen Δx, Δy, Δz, ... immer 
(für lineare Zusammenhän-
ge auch bei größeren Δx, Δy, 
Δz, ...), verlangt aber gewisse 
mathematische Grundfertig-
keiten und ist u.U. ziemlich 
aufwändig. Deshalb sollte man 
erst einmal schauen, ob für ein 
gegebenes Problem eine der  
Methoden 1 bis 3 geeignet ist, 
bevor die großen mathemati-
schen Geschütze aufgefahren 
werden.

5. Darstellung der Ergebnisse

In unserem Beispiel vom Anfang:  A = ( 5.2 ± 0.7 ) cm2

Diese Schreibweise mit absolutem Fehler ist hier besser als z.B. 5.2 ± 12.8%. Man sieht nämlich sofort, dass das 
Ergebnis ein Intervall ist, welches von  4.5  bis  5.9  reicht  (5.2 – 0.7  bis  5.2 + 0.7).

Wichtig: Das Ergebnis eines Experimentes ist nicht die Zahl, welche der Taschenrechner am Ende anzeigt, 
z.B. 5.22 oder auch 5.220745432543…, sondern immer das Intervall, welches durch die Fehlergrenzen vor-
gegeben wird. In diesem ist der wahre Wert zu vermuten, weiter kann  nichts garantiert werden. 

In unserem Beispiel hat das Intervall eine Breite von ± 0.7 cm2; damit ist es auch logisch, bei der Ergebnisdarstel-
lung alle weiteren Nachkommastellen (Hundertstel, Tausendstel, usw.) wegzulassen, da diese gegenüber 0.7 bedeu-
tungslos sind, d.h. Runden!

	 Die Ergebnisdarstellung erfolgt üblicherweise in der Form:   E  ±  ΔE
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Wie runde ich sinnvoll?

1.	 Ergebnis E mit Taschenrechner ausrechnen und erstmal die 		
	 meisten Nachkommastellen übernehmen.
2.	 Absoluten Fehler ΔE ermitteln.
3.	 Fehler ΔE auf ein oder zwei geltende Ziffern runden.
4.	 Ergebnis E auf die gleiche Zahl Nachkommastellen runden wie ΔE.

Also im Beispiel: 
 
A = ( 5.2 ±  0.7 ) cm2       oder auch   
A = ( 5.22 ± 0.67 ) cm2     

Ist es gut, schlecht, genau, ungenau? Pauschal lässt sich dazu erst einmal keine Aussage treffen. Das hängt vom 
konkreten Problem ab. In der wissenschaftlichen Praxis ist es oft so, dass ein Vergleichswert existiert (von einer 
früheren Messung, aus einem Tabellenwerk o.ä.), der bestätigt werden soll (z.B.: A = 5.5 cm2). In diesem Fall ist zu 
prüfen, ob der erwartete Wert im Fehlerintervall des Ergebnisses liegt. Das kann rechnerisch oder auch grafisch 
erfolgen.

Der Punkt soll unseren errechne-
ten Zahlenwert 5.22 symbolisieren. 
Zusammen mit den beiden sich daran 
anschließenden waagerechten Balken 
erhält man ein Intervall 5.2 ± 0.7, 
welches das eigentliche Ergebnis der 
Messung darstellt. Der Pfeil steht für 
den erwarteten (Vergleichs-) Wert.

Wenn wie hier der Vergleichswert deutlich im Fehlerintervall liegt, 
dann kann von einer Übereinstimmung im Rahmen der erreichba-
ren Messgenauigkeit gesprochen werden (Versuch gelungen!). Wenn 
nicht, dann liegt eine Abweichung des Ergebnisses vom Erwartungs-
wert vor, nach deren Ursache(n) geforscht werden muss. Denkbar 
sind grobe Fehler bei Versuchsdurchführung oder Auswertung, aber 
auch die Existenz unbekannter systematischer Fehler ist möglich.

Manchmal ist die Überschneidung allerdings auch eher negativ zu 
betrachten, wenn beispielsweise die Vorgabe heißt: Die Fläche soll 
kleiner als 5.5 cm2 sein. Nun ist zwar 5.2 kleiner als 5.5, aber da ein 
großer Teil des Ergebnisintervalls über 5.5 liegt, kann die Aussage 
A < 5.5 cm2 nicht garantiert werden. Hier müsste dann die Messme-
thode verfeinert und das Fehlerintervall verkleinert werden (vgl. dazu 
auch Anhang 1).

A in 
cm2

aber nicht:    
5.2  ± 0.6698634
5.22074543 ± 0.67
5.22074543 ± 0.6698634
usw.

Wie ist das Ergebnis zu interpretieren?
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Ein Zimmer wird eingerichtet. An einer Wand sollen nebeneinander stehen: ein Bett, ein Schrank und ein Tisch.

Die runden Zahlen, die für alle drei Längen aufgeschrieben wurden, sind ein Indiz dafür, dass die Genauigkeit der 
Messung wahrscheinlich noch nicht allzu hoch ist: mal fix gemessen und unbewusst auf 5 oder auch 10 cm gerun-
det. Realistisch dürfte bei der Messung einer Länge von rund 2 Meter mit Bandmaß alleine ohne dass man sich 
besondere Mühe gibt eine Genauigkeit von  ± 5 cm (vielleicht auch ± 3 cm) erreichbar sein. Mehr sicher nicht. Neh-
men wir an: Bett, Schrank und Tisch auf je 3 cm genau vermessen, das macht 9 cm Fehler für die Summe, d.h. statt 
3.80 m könnten es auch 3.89 m sein (bei ± 5 cm sogar 3.95 m). Bei 3.85 m Wandlänge passt es dann u.U. wirklich 
nicht mehr. 

Man hat sowas im allgemeinen schon im Gefühl, macht die „Fehlerrechnung“ quasi unbewusst und entscheidet sich 
dafür, eine weitere, diesmal genauere Messung vorzunehmen (wäre die Länge des Zimmers z.B. 4.20 m, hätte man 
sich mit der groben Messung zufriedengegeben – berechtigterweise).
Neue Messung: diesmal zu zweit, das Maßband wird richtig straff gehalten, jeder versucht, auch noch halbe Zenti-
meter mit zu berücksichtigen, es wird an verschiedenen Stellen des Schrankes gemessen usw. 

Was kommt heraus?
Bett: 1.98 m, 
Schrank (hat am Sockel noch eine 
breitere Stelle): 83 cm, 
Tisch: 1 m stimmt genau, also 1.00 m 
(Man schreibt dann tatsächlich 1.00)

Alle Größen sind jetzt auf mindestens  
±  1 cm genau. Die Summe beträgt 
3.81 m. Sie liegt damit sogar noch 
ein Stück näher am kritischen Wert, 
aber statt ± 9 cm kann ich jetzt ± 3 cm 
garantieren, d.h. max. 3.84 m. Und 
damit ist alles klar. Es wird passen. 
Nur Leute mit sehr wenig Vertrauen 
in ihre eigenen Fähigkeiten würden 
jetzt noch zweifeln.

A1: Ein Beispiel aus dem Alltag

Wo ist hier der Bezug zur Fehlerrechnung?

Wir messen mit dem Bandmaß:
Bett: 2 Meter, 
Schrank: 80 cm, 
Tisch: 1 Meter. 
Macht zusammen 3.80 m

Wir schauen auf den Grundriss, die Länge des Zimmers beträgt 3.85 m. Was nun? Das wird knapp. Wer kühn ist, 
sagt  sich jetzt: Wird schon passen. Den meisten ist das aber vermutlich zu unsicher, und sie messen vorsichtshalber 
noch mal nach.

Anhang:



E =  
  x  y2 

    z 
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C)	 Einsetzmethode:

Im Allgemeinen ergibt sich bei dieser Methode eine Diskrepanz zwischen den beiden Differenzen (Emax – E  und  
E – Emin). Ist der Gesamtfehler nicht allzu groß (< 10 .. 20%), dann  ist dieser Unterschied nur gering; man kann 
den Mittelwert bilden bzw. es genügt auch, nur  Emax – E  oder  E – Emin zu berechnen. Bei größeren Fehlern ist es 
dagegen sinnvoll, den Unterschied zu beachten. Überhaupt ist dann die Einsetzmethode das Mittel der Wahl, da die 
Verwendung der 1. Ableitung mathematisch nur bei kleinen Δ-Werten erlaubt ist.

ΔE (mittel)  ≈  0.18}

A3: Beispiel fur die Vernachlassigung 
unwichtiger Grossen

	

Zur Berechnung von  Δκ  müsste  diese  eigentlich nach allen Messgrößen (m, V, A, pL, T) partiell abgeleitet wer-
den, was insbesondere bei den Größen m und A, welche zwei Mal vorkommen, ziemlich umständlich ist.
	
Eine Abschätzung zeigt allerdings, dass die (Korrektur-) Größe nur etwa 1% des Wertes von pL ausmacht, d.h. 
dass ihre Ungenauigkeit im Vergleich zur der von pL völlig zu vernachlässigen ist. Damit kann in Hinblick auf die 
Fehlerabschätzung  weggelassen werden und die Formel besteht wieder nur aus Produkten und Quotienten. 
Anstatt der komplizierten Ableitung kann dann die Addition relativer Fehler erfolgen:

Versuch 205 – Adiabatische Zustandsänderungen

Folgende Gleichung ist gegeben:

A4: Beispiel fur die Zusammenfassung 
von Messgrossen

Versuch 203 – spezifische Wärmekapazität
Meßgrößen θfl , θf , θm , mfl , mf  und K

Folgende Gleichung ist gegeben:
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Aus  θm –  θfl   wird  θZ  , aus  θf  – θm  wird  θN , aus  c ∙ mfl + K  wird  Z  und  mf  bleibt.
(Z und N stehen für Zähler bzw. Nenner.)

	
Die Formel lautet nun:

Da sie nur noch aus Produkten bzw. Quotienten besteht, kann man die relativen Fehler addieren:

Dabei ist                                          ,                                              und

A5: Unterscheidung zufalliger und 
systematischer Fehler

Es erscheint ratsam, zu dieser Problematik ein paar ergänzende Worte zu verlieren, obwohl darüber viel in 
Büchern steht  (ein Teil dieses Bücherwissens wird hier bereits als bekannt vorausgesetzt) und sogar offizielle 
DIN-Normen existieren. Leider hilft einem vieles davon in der Praxis nicht wirklich weiter. 

In den allermeisten Fällen, wo Messgenauigkeiten abgeschätzt werden, ist sowohl der Fehler der eigentlichen, 
selbst gemessenen Größe x (als auch der des berechneten Ergebnisses E) ein Intervall der Breite  ± Δx  (bzw. ± 
ΔE) um den jeweiligen Wert. Wie ich zu diesem Δx komme, wurde weiter oben ausführlich beschrieben. Am 
Ende kann man nur sagen, dass der Messwert zwischen  x – Δx  und  x + Δx  liegt, wo aber genau, das weiß 
man nicht – deswegen „zufälliger Fehler“.

Wenn auf einem elektronischen Bauelement (z.B. Widerstand R = 100Ω) die Toleranzangabe 10% steht, so ist 
das auch ein zufälliger Fehler, da der tatsächliche Wert um 10% nach oben oder unten abweichen kann. Dieser 
Wert geht dann auch in die Fehlerrechnung ein (ΔR = ± 10Ω). Wenn jetzt allerdings jemand mit einem sehr 
genauen Ohm-Meter vorbeikommt, den Widerstand ausmisst und mir sagt, dass dieser statt der aufgedruckten 
100Ω in Wirklichkeit nur eine Größe von  97 Ω hat und das mit einer Genauigkeit von ± 1Ω, so nehme ich die 
Differenz ( 100Ω – 97Ω = 3Ω ) nicht als Fehler an, sondern rechne mit 97Ω weiter und gehe mit ± 1Ω in die 
Fehlerrechnung. Die Größe 3Ω könnte man nach offizieller Definition als systematischen Fehler bezeichnen 
und zwar als „bekannten systematischen Fehler“. Damit macht man aber keine Fehlerrechnung, sondern man 
korrigiert den Wert.

Ein weiteres Beispiel ist die 
Reaktionszeit bei der Zeit-
nahme mit einer Stoppuhr. 
Diese kann zu einem bekann-
ten systematischen Fehler 
werden, vorausgesetzt man 
hat eine Idee, wie es um die 
eigene Reaktionszeit bestellt 
ist. Dann kann (und sollte) 
man die gemessenen Werte 
korrigieren. Weiß man nichts 
Genaueres darüber, so ist die 
Reaktionszeit eher als zufälli-
ger Fehler zu betrachten. 

Solche bekannten oder erkennbaren systematischen Fehler 

gibt es viele. In Versuchsanleitungen steht oft Sätze wie: 

„Für genaue Messungen muss noch eine Korrektur der 

Form … berücksichtigt werden“. Da haben sich also bereits 

schlaue Leute Gedanken gemacht, systematische Effekte 

(= mögliche systematische Fehler) erkannt und formelmä-

ßig erfasst. Wir können auf dieses Wissen zurückgreifen 

und sollten es auch tun. Wenn die Korrektur durchgeführt 

wurde, dann ist der systematische Fehler danach nicht mehr 

existent.
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Fehlerrechnung leicht gemacht

Natürlich hat sie trotzdem in der Regel eine bestimmte Richtung und vielleicht auch immer ungefähr denselben 
Betrag (z.B. jedes Mal zwei Zehntel-Sekunden zu spät o.ä.), d.h. sie würde gut zur Definition eines systematischen 
Fehlers passen. Aber solange ich den Wert der Abweichung  nicht kenne, bleibt der Fehler ein zufälliger. Man sieht 
an diesem Beispiel, dass man oft nicht pauschal von diesem oder jener Fehlertyp sprechen kann (deshalb tut sich 
auch die DIN-Norm damit so schwer).

Wenn es sich wie im Beispiel um eine Größe handelt, die 
schon tausende Male zuvor genau vermessen wurden und 
deren Wert als gesichert gilt, so sollte man als erstes sein 
eigenes Tun und vor allem auch die Auswertung (Rechenfeh-
ler) kritisch hinterfragen.

Als nächstes müssten die Geräte überprüft und darüber 
nachgedacht werden, ob die verwendete Methode wirklich 
geeignet ist. Stellt sich dann heraus, dass ein Gerät syste-
matisch falsch angezeigt hat, der Messmethode noch ein 
Korrekturterm fehlt o.ä., so können die Ergebnisse nachträg-
lich korrigiert werden. Aus dem unbekannten ist dann ein 
bekannter systematischer Fehler geworden.

Finden sich keine Anhaltspunkte für grobe Fehler oder notwendige Korrekturen, dann wird es richtig spannend. 
Denn jetzt ist es an der Zeit, die Tabellenwerte anzuzweifeln. Evtl. muss ja die Physik an dieser Stelle umgeschrie-
ben werden und es lauert ein Nobelpreis.
 

Aber jetzt noch zum Interessantesten überhaupt: 

Unbekannte systematische Fehler

Da hat sich jemand z.B. beim Messen der Schwerebeschleunigung mit einem Pendel viel Mühe gegeben und 
ist stolz auf das genaue Ergebnis  g = (7.24 ± 0.03) m/s2, um dann beim Blick ins Tafelwerk festzustellen, dass 
ja eigentlich 9.81 hätte herauskommen sollen. 

Das ist bitter! 

Aber auch hier gibt es verschiedene Möglichkeiten, damit umzugehen.

A6: Empfehlenswerte Literatur
John Taylor: „Fehleranalyse“  (z.B. Physik-Lesesaal oder Lehrbuchsammlung Ernst-Abbe-Platz)
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